
 
module 6

 

Human Geography III

Economic Geography

 

Economic development, modernization, and trade illustrate the 
interrelatedness of the global community.

 

The Wealth of Nations: A global perspective

 

In this lesson students will be presented with the three modes of economic pro-
duction—agriculture, industry, and services—as the initial criteria for a country’s 
developed or developing status. They will select layers of data from a group of 
economic indicators to determine patterns in developed and developing countries. 
They will be challenged to draw their own conclusions as to a country’s economic 
development status and support their conclusions with data.

 

Share and Share Alike: A regional case study of North America 
and NAFTA

 

Students will explore trade in North America focusing on the three trading part-
ners in the North American Free Trade Agreement (NAFTA)—Canada, Mexico, 
and the United States. They will study export data for the past 10 years from each 
of the NAFTA countries, then use this information to identify trading trends 
before and after NAFTA, and to assess its effectiveness. Finally, students will 
make an ArcMap layout containing a map and charts that support their opinions.

 

Live, Work, and Play: An advanced investigation

 

Students will use the Internet to acquire the most recent data on job classifica-
tions in California. By exploring this data through a GIS, students will construct 
a thematic map for California counties that displays population, number of jobs 
in a given field, and average wage data. They will perform a complex query and 
create a map that illustrates their results.





 

The Wealth of Nations

 

A global perspective

 

Lesson overview

 

In this lesson students will be presented with the three modes of economic 
production—agriculture, industry, and services—as the initial criteria for a coun-
try’s developed or developing status. They will select layers of data from a group 
of economic indicators to determine patterns in developed and developing coun-
tries. They will then be asked to draw their own conclusions as to a country’s 
economic status, and to support those conclusions with data.

 

Estimated time

 

Two 45-minute class periods

 

Materials

 

✔

 

Student handouts from this lesson to be copied:
• GIS Investigation sheets (pages 333 to 342)
• Student answer sheet (pages 343 to 345)
• Assessment(s) (pages 346 to 350)

 

Standards and
objectives

 

National geography standards

 

GEOGRAPHY STANDARD MIDDLE SCHOOL HIGH SCHOOL

 

1

 

How to use maps and other geo-
graphic representations, tools, 
and technologies to acquire, 
process, and report informa-
tion from a spatial perspective

The student understands how to 
make and use maps, globes, graphs, 
charts, models, and databases to 
analyze spatial distributions and 
patterns.

The student understands how to 
use geographic representations and 
tools to analyze, explain, and solve 
geographic problems.

 

11

 

The patterns and networks of 
economic interdependence on 
Earth’s surface

The student understands ways to 
classify economic activity.

The student understands the classi-
fication, characteristics, and spatial 
distribution of economic systems.

 

18

 

How to apply geography to 
interpret the present and plan 
for the future

The student understands how vary-
ing points of view about geographic 
context influence plans for change.

The student understands how to 
use geographic knowledge, skills, 
and perspectives to analyze prob-
lems and make decisions.
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Standards and
objectives

(continued)

 

Objectives

 

The student is able to:
• Define the three economic production criteria traditionally used to determine 

economic development status.
• Compare and contrast these criteria.
• Evaluate them as suitable measurements for developed or developing status.
• Understand additional economic indicators used to classify a country as 

developed or developing.
• Develop a definition of developed and developing.
• Predict a country’s or region’s economic status within the next 20 years.

 

GIS skills and tools

 

• Add a new data frame to a layout
• Symbolize data using graduated colors
• Build a query to exclude specific attribute values from classification
• Display excluded values in a No Data class

For more on geographic inquiry and these steps, see Geographic Inquiry and GIS 
(pages xxiii to xxv).

Zoom the layout to view the whole page

Zoom in to a specific area of the map

Activate a data frame in a layout

Find a specific feature on the map and identify it

Zoom to the full map extent

Add a layer to the map
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Teacher notes

 

Lesson
introduction

 

Introduce this lesson to your students with a discussion of the three economic 
production criteria: agriculture, industry, and services. Ask them what they 
know about these three methods of earning a living. Explain to them that econo-
mists generally rate a country’s economic status as developing or developed by 
how much of its workforce is engaged in agriculture, industry, and services. 
Generally, countries with a high percentage of the workforce in agriculture 
(whether it be subsistence, commercial, or another type) are placed in the cate-
gory of “developing.”

Have the class begin by using the three production criteria maps of the world to 
determine whether a country is classified as developed or developing. 

Before starting the exercise on the computer, ask the following questions to elicit 
knowledge, beliefs, or ideas your students may already have about countries 
around the world:
• Name several countries that have a high percentage of their workforce 

participating in agriculture.
• Name a country that has a high percentage of its workforce participating in 

services.
• Which countries do we generally think of as highly industrialized (have high 

percentages of the workforce participating in industry)?
• Can they think of other factors that might be helpful in determining whether a 

country is developed or developing?

 

Student activity Before completing this lesson with students, we recommend that you 
complete it as well. Doing so will allow you to modify the activity to 
accommodate the specific needs of your students.

 

After the initial discussion, have the students work on the computer component 
of the lesson individually or in groups of no more than two or three. Distribute 
the GIS Investigation sheets to the students. Explain to them that they will learn 
and use GIS skills to enable them to gather data for the assessment worksheet.

In addition to instructions, the handout includes questions to help students focus 
on key concepts.

 

Teacher Tip: In order for students to complete the assessment, they must 
save their project. Be sure to have a suggested naming convention and 
location on a computer or computer network for your students. 

 

Things to look for while students are working on this activity:

• Are all students in each group participating in the activity, taking turns using 
the computer and writing information on the chart?

• Are the students using a variety of tools to obtain the information they need?
• Are they experiencing any difficulty symbolizing the economic data layers in 

step 7?
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Conclusion

 

After the students complete the lesson and the assessment, discuss their find-
ings. If you have time, you can have each group share findings on an overhead 
projector and explain how they came to their conclusions. Students can also take 
turns presenting the thematic maps they have created, either in printed format 
or on a computer projection device from the front of the room. Conclude the les-
son by asking the students to explain which factors they feel are most important 
in deciding if a country is developed or developing, and to provide support for 

 

their evaluation. Do they feel this two-class system (“developed” and “developing”)

 

 
is adequate? What alternative or additional classes can they suggest to describe a 
country’s economic status?

 

Assessment

 

Middle school and high school: Highlights skills appropriate to grades 
5 through 12

 

The middle- and high-school assessments ask students to choose one country they 
believe is developed and another they believe is developing. Students will use the 
thematic mapping skills they have learned in this lesson to map additional indica-
tors and draw conclusions about the two countries they have chosen. They will 
individually write an essay that answers specific questions. The middle- and high-
school assessments differ in the types of questions asked. 

 

Extensions

 

• Ask students to look in local newspaper employment advertisements to 
classify the jobs in their own community as agriculture, industry, or service. 
How would they classify the types of employment in their own community?

• Research employment classifications of two different counties, and compare 
and contrast the percentages of jobs in each category.

• Research the GDP for the top 10 trading partners of the United States, compute 
the GDP per capita, and map it.

• Have students choose a country and analyze all of the standard of living and 
economic indicator data, and present their findings orally to the rest of the class. 

• Check out the Resources by Module section of this book’s companion Web site 

 

(www.esri.com/mappingourworld)

 

 for print, media, and Internet resources 
on the topics of economic indicators, developing countries, and economic 
production of countries.
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NAME __________________________________________________ DATE ________________________

 

The Wealth of Nations

 

A GIS investigation

 

Answer all questions on the student answer sheet handout

 

Economists generally classify a country’s economic status as developing or developed by 
determining the percentage of its workforce engaged in each of three sectors of the economy—
agriculture, industry, and services. In general, a country with a high percentage of its work-
force in agriculture is considered to be “developing,” while a country with a high percentage of 
its workforce in services and industry is considered to be “developed.”

In this GIS Investigation, you will use world maps of the workforce in the three employment 
sectors to explore patterns of development around the world. You will also examine two other 
economic indicators—energy use and GDP per capita—and compare the maps of employment 
sectors to the maps of GDP and energy use. You will evaluate whether or not the employment 
criteria are good indicators of a country’s economic status.

 

Step 1 Start ArcMap

 

a

 

Double-click the ArcMap icon on your computer’s desktop.

 

b

 

If the ArcMap start-up dialog appears, click 

 

An existing map

 

 and click OK. Then go 
to step 2b. 
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Step 2 Open the Global6.mxd file

 

a

 

In this exercise, a map document has been created for you. To open it, go to the File 
menu and choose 

 

Open

 

.

 

b

 

Navigate to the module folder (

 

C:\MapWorld9\Mod6

 

) and choose 

 

Global6.mxd

 

 
(or 

 

Global6

 

) from the list.

 

c

 

Click Open.

 

When the map document opens, you see a world map of employment in the agricul-
tural sector. The table of contents lists three data frames in all, one for each of the 
employment sectors.

 

d

 

Click the Layout View button below the map.

 

The layout shows all three data frames side by side on the layout so you can compare

 

 
them. Also, the Layout Toolbar appears or becomes active.

 

e

 

If your Layout toolbar is floating, dock it above the table of contents.

 

f

 

Maximize your ArcMap window by clicking the Maximize button in the top right corner 
of the window.

 

g

 

Click the Zoom Whole Page button on the Layout toolbar to make the layout fill 
the view.
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Step 3 Evaluate the legends and patterns of the maps

 

a

 

Look at all of the legends in the table of contents.

 

(1) What do the darkest colors represent?

(2) What do the lightest colors represent?

 

b

 

Study the Workforce Involved in Agriculture map.

 

(1) What does the description “Very High” refer to in this map?

(2) Where are the countries with a high percentage of agricultural workers generally 
located?

(3) Where are the countries with a low percentage of agricultural workers generally 
located?

 

c

 

Study the Workforce Involved in Services map.

 

(1) Where are the countries with a high percentage of service workers generally 
located?

(2) Where are the countries with a low percentage of service workers generally 
located?

(3) What relationship, if any, do you see between the agriculture and services 
workforce maps?

 

d

 

Study the Workforce Involved in Industry map.

 

What patterns do you see on the map?

 

e

 

Using the workforce information in all three maps, in what part or parts of the world 
do you find the greatest number of developing countries?

Step 4 Analyze data on Bolivia

 

a

 

Click the Zoom In tool on the Tools toolbar.

 

b

 

Click and drag a box around South America in the Workforce Involved in Industry map.

 

c

 

Zoom in to South America on the other two maps.
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d

 

Click the Select Elements tool and click the Agriculture map to activate the data frame. 
The data frame is outlined with a colored dashed line with blue squares to indicate it 
is active.

 

e

 

Click the Find tool.

 

f

 

Type 

 

Bolivia

 

 in the Find box on the Features tab. 

 

g

 

Click the circle next to 

 

In fields

 

 in the Search area. Then select CNTRY_NAME from 
the drop-down list as the field to search.

 

h

 

Click Find.

 

Bolivia is listed in the results box at the bottom of the Find window. Now you will 
use ArcMap to gather and record data about Bolivia.

 

i

 

Move the Find window so you can see the Agriculture map.

 

j

 

Right-click the Bolivia row in the results box and choose Flash feature so that you can 
pick out Bolivia on the map.

 

k

 

Right-click Bolivia again, and choose Identify feature(s). Close the Find dialog.

 

The Identify Results window shows data on Bolivia.

 

l

 

Scroll down the right side of the window and complete the following questions:

 

(1) What percentage of workers in Bolivia are involved in agriculture?

(2) What percentage of workers in Bolivia are involved in industry?

(3) What percentage of workers in Bolivia are involved in service?

(4) Assume that a developing country has a high percentage of its workforce in 
agriculture and lower percentages of its workforce in industrial-and service-
related occupations and analyze the data on Bolivia. Based on these criteria, 
would you classify Bolivia as a developed or developing country? Explain.
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m

 

Close the Identify Results window.

 

n

 

On your answer sheet, you see a table that has some information completed for Bolivia. 
Record the classification (developed or developing) you gave Bolivia in the previous 
question by making a check mark in the appropriate column.

Step 5 Analyze data on other countries

 

In order to complete the table on your answer sheet, you will need to find each 
country on the maps, interpret the legends for each map, write your answers in the 
columns under Agriculture, Industry, and Service, and decide whether each country 
is developing or developed.

 

a

 

Click the Find tool and type 

 

India

 

 in the Find text box. Click Find.

 

Two countries are found that contain the word India in the country name, but only 
one of them is the one you want.

 

b

 

Right-click the India row and choose Zoom to feature(s). The map zooms to the country 
of India.

 

c

 

Write the correct category for the percentage of workers in agriculture in the table on 
your answer sheet (under step 4n).

 

d

 

Using the Select Elements tool, activate the Workforce Involved in Industry data frame.

 

e

 

Click Find in the Find dialog to search the newly active data frame. Then Zoom to India.

The Workforce Involved in Industry data frame zooms to India.

f Interpret the legend and record India’s percentage in the table on your answer sheet 
(under step 4n).

g Activate the Workforce Involved in Service data frame. Click Find to find India and 
then zoom to it.

h Interpret the legend and record India’s percentage in the table on your answer sheet 
(under step 4n).

i Based on the workforce criteria previously used to determine if a country is developed 
or developing, write your answer for India in the table on your answer sheet (under 
step 4n).

j Repeat this process (step 5a–5i) for the other countries listed in the table.

k Close the Find dialog.

l Use the Select Elements tool and the Full Extent button to activate each data frame 
and zoom to the entire world in all three maps.
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Step 6 Create a new data frame and add data

Now you will add economic and energy data and determine whether this data sup-
ports your initial conclusions about which countries are developed and which are 
developing.

Gross Domestic Product (GDP) is the total value of all goods, services, and products 
produced in a given country. Typically, developing countries have a low GDP. The 
total amount of energy consumed by a given country is also an indicator of develop-
ment. If a country has a low level of energy consumption, it tends to be a developing 
country. Developed countries are high in both GDP and energy use.

a Click Insert on the Main Menu toolbar and choose Data Frame to add a new data 
frame to the map document.

b With the Select Elements tool, click the new data frame and drag it into the blank 
space in the bottom right of the layout.

c Click and drag the blue boxes to resize the data frame to match the others.

d In the table of contents, click slowly two times on New Data Frame 3 to activate the 
text cursor. Name the data frame Economic Data.

e Click the Add Data button.

f Navigate to the module data folder (C:\MapWorld9\Mod6\Data). Open the 
World6.mdb geodatabase and choose world_economics from the list. Click Add.

g Add world_economics again so there are two copies of it in the data frame.

For each new layer, all countries are symbolized with one color. ArcMap randomly 
assigns the color, so the color on your screen may not match the color on your 
neighbor’s screen.
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Step 7 Thematically map GDP per capita and energy use

To see the pattern of GDP per capita, you need to change the legend. GDP per cap-
ita is the gross domestic product per person in a given year (1998). It is calculated 
by dividing the GDP of a country by its total population.

a Double-click the first world_economics layer name in the table of contents. The Layer 
Properties dialog is displayed.

b Click the Symbology tab.

c Click Quantities in the Show list on the left side of the dialog. Graduated colors is 
automatically selected.

d Click the Value drop-down list, scroll down, and select GDP_PC8.

The Symbology tab updates and you see a list of five colored symbols, values, and 
labels.

e For the Color Ramp choose Brown Light to Dark. (Hint: To choose the color ramps by 
name instead of colors, right-click the drop-down list and choose Graphic View to 
toggle the colors off.)

By default, ArcMap has divided the GDP per capita values into five groups, or 
classes, which are shown in the Range column.

For some countries no data was available for GDP per capita. In this case, the 
GDP_PC8 field has a value of –99. Because the value of –99 represents no data, it 
should not be included in the range of GDP per capita values. You will assign values 
of –99 to a No Data class.

f Click the Classify button on the right side of the Symbology tab. Then in the next 
dialog, click the Exclusion button.

g Click the Query tab in the Data Exclusion dialog.

You will build the following query expression: [GDP_PC8] = –99
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h Scroll down the Fields list and find GDP_PC8. Double-click GDP_PC8 to add it to the 
expression box.

i Click the = button.

j Click the Get Unique Values button, then double-click –99 to complete the query 
expression.

k Click the Verify button. If you receive a message that the expression was successfully 
verified, click OK to close the message. If you get a different message, check your 
work and make sure the query expression matches the one pictured above.

l Click the Legend tab. Check the box to Show symbol for excluded data.

m Click the Symbol color and change the fill color to Gray 30%. Click OK on the Symbol 
Selector.

n In the Label box, type No Data.

o Click OK in the Data Exclusion Properties and Classification dialogs.

The ranges in the Symbology tab no longer include the value –99. Next you will 
change the labels for each symbol to use words instead of numbers.

p Click on the top label (488.840000 - 2498.640000). Type Very Low and press Enter. 

q Change the next label down to Low. Then change the rest of the labels to Moderate, 
High, and Very High.

r Click the General tab in the Layer Properties window. Change the layer name to 
GDP per capita.
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s Click OK and look at the updated legend.

Next you will map energy use. Energy use is a measure of the total energy consump-
tion from all energy sources as measured by a trillion BTUs (British thermal units). 
One BTU is the amount of energy needed to heat one pound of water one degree 
Fahrenheit.

t Turn off GDP per capita.

u Double-click the remaining world_economics layer to open its Layer Properties dialog. 
Repeat steps 7b–7s using the information below:

• Map the value field ENER_USE9
• Use the Orange Bright color ramp
• Use the query expression [ENER_USE9 = -99]
• Change the layer name to Energy Use
• Use the same scale (Very Low – Very High) for the labels

Step 8 Analyze GDP per capita and energy use data

Now you will take this new data on GDP per capita and energy use into consideration, 
and you will reevaluate how you classified countries as developed or developing.

a Turn off Energy Use and turn on GDP per capita.

b Click the Find tool and find Bolivia. Zoom to Bolivia. Answer the following questions.

(1) What level is the GDP per capita for Bolivia?

(2) Based on this new information and the workforce data, should Bolivia be 
classified as a developing or developed country? Why?

c Turn off GDP per capita and turn on Energy Use.

(1) What level is the energy use for Bolivia?

(2) Based on this new information and previous data, should Bolivia be classified as 
a developing or developed country?

(3) Why does energy use increase when a country develops?

Now you will explore the data as it pertains to other countries and you will see if 
your earlier classification of each country has changed.

d Explore GDP per capita and Energy Use for each of the countries listed on your answer 
sheet. You may consult your previous classification of these countries by looking at 
the table from step 4.

(1) Complete the table on your answer sheet.

(2) Name one country from above that you earlier classified as developed and that 
has GDP and energy use data that indicates it is developing.

(3) Based on the data you collected on these six countries, do you feel that the 
employment criteria are good indicators of a country’s economic status? Explain 
your answer.
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Step 9 Save the map document and exit ArcMap

In this exercise, you used workforce data to determine whether countries should be 
classified as developed or developing. You added new data, thematically mapped 
the data, and reevaluated your previous classifications.

a Click the Full Extent button so you can see the entire world in the Economic Data map.

b Choose Save As from the File menu. Ask your teacher for instructions on where to 
save the map document and how to rename it. You must save this map document 
because you will need it for the assessment.

c Write the new name you gave the map document and where you saved it in the space 
on your answer sheet.

d Click the Restore Down button to return the ArcMap window to its original size.

e From the File menu, click Exit.
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NAME __________________________________________________ DATE ________________________

Student answer sheet
Module 6
Human Geography III: Economic Geography

Global perspective: The Wealth of Nations

Step 3 Evaluate the legends and patterns of the maps
a-1 What do the darkest colors represent?

____________________________________________________________________________________

a-2 What do the lightest colors represent?
____________________________________________________________________________________

b-1 What does the description “Very High” refer to in this map?
____________________________________________________________________________________

b-2 Where are the countries with a high percentage of agricultural workers generally located?
____________________________________________________________________________________

b-3 Where are the countries with a low percentage of agricultural workers generally located?
____________________________________________________________________________________

c-1 Where are the countries with a high percentage of service workers generally located?
____________________________________________________________________________________

c-2 Where are the countries with a low percentage of service workers generally located?
____________________________________________________________________________________

c-3 What relationship, if any, do you see between the agriculture and services workforce maps?
____________________________________________________________________________________

d What patterns do you see on the map?
____________________________________________________________________________________

e Using the workforce information in all three maps, in what part or parts of the world do you find the 
greatest number of developing countries?
____________________________________________________________________________________
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Step 4 Analyze data on Bolivia
l-1 What percentage of workers in Bolivia are involved in agriculture? ______________________________

l-2 What percentage of workers in Bolivia are involved in industry? _________________________________

l-3 What percentage of workers in Bolivia are involved in service? __________________________________

l-4 Would you classify Bolivia as a developed or developing country? Explain.
___________________________________________________________________________________

___________________________________________________________________________________

___________________________________________________________________________________

___________________________________________________________________________________

n In the table below, record the classification (developed or developing) you gave Bolivia in the previous 
question. Complete the rest of the table by following the instructions in step 5.

Step 8 Analyze GDP per capita and energy use data
b-1 What level is the GDP per capita for Bolivia? _________________________________________________

b-2 Based on this new information and the workforce data, should Bolivia be classified as a developing or 
developed country?
___________________________________________________________________________________

Why?
___________________________________________________________________________________

___________________________________________________________________________________

c-1 What level is the energy use for Bolivia? ____________________________________________________

c-2 Based on this new information and previous data, should Bolivia be classified as a developing or 
developed country?
___________________________________________________________________________________

c-3 Why does energy use increase when a country develops?
___________________________________________________________________________________

COUNTRY AGRICULTURE INDUSTRY SERVICE DEVELOPING DEVELOPED

Bolivia High Low High

India

Australia

South Korea

Ukraine

Uruguay
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d-1 Complete the table below.

d-2 Name one country from above that you earlier classified as developed and that has GDP and energy use 
data that indicates it’s developing.
____________________________________________________________________________________

d-3 Based on the data you collected on these six countries, do you feel that the employment criteria are 
good indicators of a country’s economic status? Explain your answer.
____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

Step 9 Save the map document and exit ArcMap
c Write the new name you gave the map document and where you saved it in the space below.

______________________________________ ______________________________________
(Name of map document. (Navigation path to where map document is saved.

For example: ABC_Global.mxd) For example: C:\Student\ABC)

COUNTRY GDP PER CAPITA ENERGY USE
DEVELOPED OR 
DEVELOPING

IS THIS A CHANGE 
FROM YOUR EARLIER 

CLASSIFICATION? 

Bolivia

India

Australia

South Korea

Ukraine

Uruguay
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NAME ___________________________________________________ DATE _________________________

The Wealth of Nations
Middle school assessment 

1 Open your saved version of the Global6 map document (e.g., ABC_Global6). Use the three 
economic activity maps (agriculture, services, and industry) to select a country you believe is 
a developed country and one that you believe is a developing country. Write the names of 
those countries at the top of the sheet provided.

2 Activate the Economic Data data frame and add a world_economics layer from the World6 
geodatabase. Switch to Data View.

3 Thematically map the developing country indicators in the world_economics attribute table. 
Refer to the attached assessment sheet for guidelines on which data to map (page 350). 
(Hint: You can copy the world_economics layer and paste it into the data frame for each 
attribute you map. You may also want to collapse any unneeded data frames table of 
contents to make your work easier.)

4 Record the information you observe from the new maps on the attached sheet. You may use 
other developing country indicators that are not listed on the sheet. Write those in the blank 
lines at the end of the table.

5 Look at the data in the two columns and decide if your initial prediction is correct. 
6 Write an essay that includes or answers the following information and questions:

• Name and description of the three economic production models.
• Does the data you found about your selected countries support what economists say about 

economic production as an indicator of developed or developing status?
• Your own definitions, based on your research, of a developed country and a developing 

country.
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This is a four-point rubric based on the National Standards for Geographic Education. The “Mastery” level meets the target objective for 
grades 5–8.

STANDARD EXEMPLARY MASTERY INTRODUCTORY DOES NOT MEET REQUIREMENTS

The student understands 
how to use maps and 
databases to analyze 
spatial distributions and 
patterns.

Uses GIS to analyze economic 
data by creating at least seven 
thematic maps that compare and 
contrast the different economic 
indicators for two countries. Uses 
additional data from outside 
sources.

Uses GIS to analyze economic 
data by creating seven thematic 
maps that compare and contrast 
the different economic indicators 
for two countries.

Uses GIS to analyze economic 
data by creating five or six the-
matic maps that compare and 
contrast the economic indicators 
for two countries.

Uses GIS to create four or fewer 
thematic maps based on eco-
nomic data for one or two 
countries.

The student understands 
ways to classify economic 
activity.

Clearly describes the three eco-
nomic production models and 
provides an example of each. Cre-
ates detailed and accurate origi-
nal definitions of developed and 
developing countries. Provides 
ample evidence for the definition.

Clearly describes the three eco-
nomic production models and 
then creates an accurate and orig-
inal definition of developed and 
developing countries.

Describes the three economic pro-
duction models, and attempts to 
create original definition of devel-
oped and developing countries.

Has difficulty describing the three 
economic production models, and 
does not attempt to create origi-
nal definitions for developed and 
developing countries.

The student understands 
the spatial organization of 
human activities and phys-
ical systems and is able to 
make informed decisions.

The student understands how 
varying points of view about geo-
graphic context influence plans for 
change.

Compares own findings with the 
predefined economic status of the 
selected countries. Identifies any 
inconsistencies in the findings, 
and either accepts or rejects his/
her hypothesis.

Compares and contrasts own 
findings with the predefined eco-
nomic status of the selected 
countries.

Lists own ideas on the economic 
status of the selected country (or 
countries), but does not draw any 
comparisons with predefined eco-
nomic status.



Global perspective: The Wealth of Nations Student assessment: High school

MODULE 6 • HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

348

P
H
O
T
O
C
O
P
Y

NAME ___________________________________________________ DATE _________________________

The Wealth of Nations
High school assessment 

1 Open your saved version of the Global6 map document (e.g., ABC_Global6). Use the three 
economic activity maps (agriculture, services, and industry) to select a country you believe is 
a developed country and one that you believe is a developing country. Write the names of 
those countries at the top of the sheet provided.

2 Activate the Economic Data data frame and add a world_economics layer from the World6 
geodatabase. Switch to Data View.

3 Thematically map the developing country indicators in the world_economics attribute table. 
Refer to the attached assessment sheet for guidelines on which data to map (page 350). 
(Hint: You can copy the world_economics layer and paste it into the data frame for each 
attribute you map. You may also want to collapse any unneeded data frames table of 
contents to make your work easier.)

4 Record the information you observe from the new maps on the attached sheet. You may use 
other developing country indicators that are not listed on the sheet. Write those in the blank 
lines at the end of the table.

5 Look at the data in the two columns and decide if your initial prediction is correct. 
6 Write an essay that includes or answers the following information and questions:

• Name and description of the three economic production models. Give a brief explanation 
of the relationship between those models. For example: Will a country usually have high 
percentages or low percentages in all three production areas?

• Does the data you found about your selected countries support what economists say about 
economic production as an indicator of developed or developing status?

• Your own definitions, based on your research, of a developed country and a developing 
country.

• Prediction of changes in your countries’ economic status by the year 2020, and supporting 
data. 
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This is a four-point rubric based on the National Standards for Geographic Education. The “Mastery” level meets the target objective for 
grades 9–12.

STANDARD EXEMPLARY MASTERY INTRODUCTORY DOES NOT MEET REQUIREMENTS

The student understands 
how to use geographic 
representations and tools 
to analyze and explain 
geographic problems.

Uses GIS to analyze economic 
data by creating at least seven 
thematic maps that compare and 
contrast the different economic 
indicators for two countries. Uses 
additional data from outside 
sources.

Uses GIS to analyze economic 
data by creating seven thematic 
maps that compare and contrast 
the different economic indicators 
for two countries.

Uses GIS to analyze economic 
data by creating five or six the-
matic maps that compare and 
contrast the economic indicators 
for two countries.

Uses GIS to create four or fewer 
thematic maps based on eco-
nomic data for one or two 
countries.

The student understands 
the classification, charac-
teristics, and spatial distri-
bution of economic 
systems.

Clearly describes the three 
economic production models, 
explains the relationship between 
these models, and then creates 
original detailed definitions of 
developed and developing coun-
tries. Provides ample evidence 
and examples for each.

Clearly describes the three 
economic production models, 
explains the relationship between 
these models, and then creates 
original detailed definitions of 
developed and developing coun-
tries. Provides some evidence and 
examples for each.

Describes the three economic pro-
duction models, and attempts to 
create original definition of devel-
oped and developing countries.

Has difficulty describing the three 
economic production models, and 
does not attempt to create origi-
nal definitions for developed and 
developing countries.

The student understands 
how to use geographic 
knowledge, skills, and per-
spectives to analyze prob-
lems and make decisions.

Compares own findings with the 
predefined economic status of the 
selected countries. Identifies any 
inconsistencies in the findings, 
and either accepts or rejects his/
her hypothesis. Refines original 
hypothesis based on the findings. 
Predicts future changes for the 
economic status of the countries 
giving specific examples.

Compares own findings with the 
predefined economic status of the 
selected countries. Identifies any 
inconsistencies in the findings, 
and either accepts or rejects his/
her hypothesis. Predicts any future 
changes for the economic status 
of the countries.

Compares and contrasts own 
findings with the predefined eco-
nomic status of the selected coun-
tries. Attempts to predict future 
changes in economic status, but 
does not provide enough 
evidence.

Lists own ideas on the economic 
status of selected country (or 
countries), but does not draw any 
comparisons with predefined eco-
nomic status.
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DEVELOPING COUNTRY INDICATORS DEVELOPED COUNTRY

_______________________________

DEVELOPING COUNTRY

_______________________________

High birth rates

Moderately high death rates

High infant mortality rate

Low life expectancy at birth

Large percentage of population under 15

Literacy rates low

High urban populations

Low gross domestic product

Low consumption of energy

Higher percentage per person 
communication facilities

Economic production criteria—write 
whether they are predominantly agricul-
ture-, industry-, or service-based.

Other criteria:

____________________________________

Other criteria:

____________________________________

Other criteria:

____________________________________



 

Share and Share Alike

 

A regional case study of North America 
and NAFTA

 

Lesson overview

 

Students will explore trade in North America focusing on the three trading part-
ners in the North American Free Trade Agreement (NAFTA)—Canada, Mexico, 
and the United States. They will study export data for the past 10 years from 

 

each of the NAFTA countries, then use this information to identify trading trends

 

 
before and after NAFTA, and to assess its effectiveness. Finally, students will 
make a layout containing a map and charts that support their opinions.

 

Estimated time

 

Two to three 45-minute class periods

 

Materials

 

✔

 

Student handouts from this lesson to be copied:
• NAFTA objectives handout (page 356)
• GIS Investigation sheets (pages 357 to 369)
• Student answer sheet (pages 371 to 375)
• Assessment(s) (pages 376 to 379)

 

Standards and
objectives

 

National geography standards

Objectives

 

The student is able to:
• Explain the concept of imports and exports related to trade balances of a country.

• Evaluate the effectiveness of NAFTA.

• Create a layout that displays the results of the student’s research.

 

GEOGRAPHY STANDARD MIDDLE SCHOOL HIGH SCHOOL

 

1

 

How to use maps and other geo-
graphic representations, tools, 
and technologies to acquire, 
process, and report informa-
tion from a spatial perspective

The student understands how to 
make and use maps, globes, charts, 
models, and databases to analyze 
spatial distributions and patterns.

The student understands how to 
use geographic representations and 
tools to analyze, explain, and solve 
geographic problems.

 

11

 

The patterns and networks of 
economic interdependence on 
Earth’s surface

The student understands the basis 
for global interdependence.

The student understands the 
increasing economic interdepen-
dence of the world’s countries.

 

13

 

How the forces of cooperation 
and conflict among people 
influence the division and con-
trol of Earth’s surface

The student understands how coop-
eration and conflict among people 
contribute to economic and social 
divisions of Earth’s surface.

The student understands why and 
how cooperation and conflict are 
involved in shaping the distribution 
of social, political, and economic 
spaces on Earth at different scales.
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GIS skills and tools

 

• Open the attribute table for a layer
• Relate a table to a layer attribute table
• Update a relate to reflect a change in selected features
• Clear all selected features
• Open a graph and display data for a specific map feature
• Modify a graph’s appearance
• Add graphs to a layout
• Print a layout

For more on geographic inquiry and these steps, see Geographic Inquiry and GIS 
(pages xxiii to xxv).

Display attributes for a specific feature

Select a feature on the map

Zoom the layout to view the whole page

Zoom out a fixed amount on the map

Move elements in a layout

Add text to a layout

Zoom to the full map extent

Add data to the map



 

Lesson overview and teacher notes

 

Regional case study: Share and Share Alike

 

353

 

MODULE 6

 

• HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

 

Teacher notes

 

Lesson
introduction

 

This lesson is designed to correspond with a unit on NAFTA. Before you start 
this lesson, we suggest that you review the history of NAFTA. You may want to 
visit the following Web sites:
•

 

www.customs.ustreas.gov/nafta

 

Provides links to NAFTA customs and other information from each of the 
three countries.

•

 

www.dfait-maeci.gc.ca/nafta-alena/menu-e.asp

 

Presents clear and concise information on the history of NAFTA and continuing 
NAFTA issues.

•

 

www.sice.oas.org/indexe.asp

 

Contains excellent information on NAFTA as well as on foreign trade in general.

 

Note: Due to the dynamic nature of the Internet, the URLs listed above 
may have changed. If the URLs do not work, refer to this book’s Web site 
for an updated link: www.esri.com/mappingourworld.

 

Additional resources on NAFTA are listed on this book’s Web site 

 

(www.esri.com/mappingourworld).

 

Your students should have a working knowledge of basic economics in addition to 
background information on NAFTA. Make sure they are familiar with the terms 
trade, imports, exports, trade balance, and tariffs. Basic graph-reading skills will 
also be essential.

Begin the lesson with a discussion of the North American Free Trade Agreement 
(NAFTA) as spelled out in the NAFTA objectives handout included with this 
lesson. Ask your students to explain the objectives of NAFTA in their own words. 
This exercise could be done as a class activity on the board or in groups with 
several sets of goals being developed. Note: You may want to save the results so 
students can refer to them when they evaluate NAFTA in step 8.

When you are satisfied that your students have a handle on NAFTA, discuss the 

 

flow of goods into and out of a country and the concept of trade balance. Introduce

 

 
the following formula for trade balance:

 

EXPORTS – IMPORTS = TRADE BALANCE (trade surplus or deficit)
When exports are more than imports, you have a trade surplus.
When imports are more than exports, you have a trade deficit.

 

Ask the students to predict the trade balance between each of the NAFTA 
countries.

 

Student activity

 

Before completing this lesson with students, we recommend that you work

 

 
through it yourself. Doing so will allow you to modify the activity to 
accommodate the specific needs of your students.

 

Student work on the computer component of the lesson follows the initial discus-
sion. Ideally each student should be at an individual computer, but the lesson 
can be modified to accommodate a variety of instructional settings.

On the first day, distribute the GIS Investigation sheets to the students. Explain 
that in this activity they will create graphs and maps to explore and report on 
the patterns of trade over the past 10 years between the NAFTA countries. In 
addition, they will use the graphs to identify whether NAFTA achieved its goals 
as outlined in the objectives discussed in class.
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Student activity
(continued)

 

The worksheets will provide students with detailed instructions for their investi-
gations. As they navigate through the lesson, they will be asked questions that 
will help keep them focused on key concepts. Some questions will have specific 
answers while others will require creative thought.

Things to look for while the students are working on this activity:
• Are students using a variety of tools?
• Are they answering the questions as they work through the procedure?
• Do they need help with the lesson’s vocabulary?

 

Teacher Tip: Step 7 of this GIS Investigation contains instructions for 
students to stop and save their work. This is a good spot to stop the class 
for the day and to pick up the investigation the next day. Be sure your 
students know how to rename their project and where to save it. We 
recommend that you spend two class periods doing the GIS Investigation 
and allow one period for work on the assessment.

Conclusion

 

At the completion of the lesson, have the students present to the class their trad-
ing history layouts and answers to their initial predictions. Ask them to describe 
the trade balances between each of the countries and also whether they think 
NAFTA has succeeded in achieving its goals. Finally, the students should evalu-
ate whether or not NAFTA should remain in place. Tally up the results and 
report to the class what their combined opinion suggests.

 

Assessment

 

Middle school: Highlights skills appropriate to grades 5 through 8

 

Students will create and present layouts that illustrate the history of trade 
between Mexico and the United States, using maps they have made, graphs, text, 
and graphics. Presenters will describe the trade balance between the countries, 
and indicate whether they think NAFTA has achieved its goals. Presentations 
will conclude with students offering opinions about whether NAFTA should 
remain in place, using information from their layout to support those opinions.

 

High school: Highlights skills appropriate to grades 9 through 12

 

Students will create and present layouts that illustrate the history of trade 
between Mexico and the United States, using maps they have made, charts, text, 
and graphics. Presenters will describe the trade balance between the countries, 
and indicate whether they think NAFTA has achieved its goals. Presentations 
will conclude with students offering opinions about whether NAFTA should 
remain in place, using information from their layout to support those opinions. 
Finally, students will write a paragraph describing how they would change the 
NAFTA agreement to improve or enhance future trading for all three countries.

 

Extensions

 

• Have the students research the history of NAFTA.
• Have students acquire similar data for the European Union, OPEC, and the 

Organization of American States, and compare and contrast the outcomes of 
NAFTA and the European Union.

• Have students map the movements of commodities from the NAFTA countries 
in which they were produced, to countries where they are bought and used. 

• Go to Statistics Canada, U.S. Census Bureau, and INEGI sites to obtain total 
international export information and map that information.
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• NAFTA affects other aspects of each nation’s economy, such as employment 
rates. Have students research employment trends since the advent of NAFTA. 
Have the NAFTA countries experienced increased employment or unemployment 
since 1994?

• Ask the students to do research on the employment/unemployment figures in 
the United States, Canada, and Mexico since NAFTA was initiated in 1994, 
and to report if there was a substantial change in employment/unemployment 
figures since January 1, 1994.

• Check out the Resources by Module section of this book’s companion Web site 

 

(www.esri.com/mappingourworld)

 

 for print, media, and Internet resources on 
the topics of economics, trade, and NAFTA.
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NAFTA objectives handout

 

The North American Free Trade Agreement (NAFTA) came into effect on January 1, 1994. This 
agreement created the world’s largest free trade area. Among the agreement’s main objectives 
are the liberalization of trade between Canada, Mexico, and the United States, stimulation of 
economic growth in all three countries, and equal access to each other’s markets.

 

NAFTA Articles 101 and 102

 

Article 101: Establishment of the Free Trade Area

 

The Parties to this Agreement, consistent with Article XXIV of the General Agreement on 
Tariffs and Trade, hereby establish a free trade area.

 

Article 102: Objectives

1

 

The objectives of this Agreement, as elaborated more specifically through its principles and 
rules, including national treatment, most-favored-nation treatment and transparency are to:

 

(a)

 

eliminate barriers to trade in, and facilitate the cross border movement of, goods and 
services between the territories of the Parties;

 

(b)

 

promote conditions of fair competition in the free trade area;

 

(c)

 

increase substantially investment opportunities in the territories of the Parties;

 

(d)

 

provide adequate and effective protection and enforcement of intellectual property rights 
in each Party’s territory;

 

(e)

 

create effective procedures for the implementation and application of this Agreement, for 
its joint administration and the resolution of disputes; and 

 

(f)

 

establish a framework for further trilateral, regional and multilateral cooperation to 
expand and enhance the benefits of this Agreement.

 

2

 

The Parties shall interpret and apply the provisions of this Agreement in the light of its 
objectives set out in paragraph 1 and in accordance with applicable rules of international law.

 

From the North American Free Trade Agreement between the Government of Canada, the 
Government of the United Mexican States, and the Government of the United States of 
America, published January 1, 1994, as written in the U.S. Customs Department Web site 
(www.customs.gov/impoexpo/nafta_newf.htm).
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NAME __________________________________________________ DATE ________________________

 

Share and Share Alike

 

A GIS investigation

 

Answer all questions on the student answer sheet handout

 

On January 1, 1994, the North American Free Trade Agreement (NAFTA) was enacted to 
enhance trade and increase access to the total trade market available to businesses in North 
America. Tariffs and quotas were eliminated to increase the competitiveness of goods produced 
by all North Americans. Now, a decade after NAFTA’s inception, your task will be to evaluate 
whether these objectives have been accomplished for all three countries involved. In this lesson 
you will create and analyze graphs of exports and trade balances for the NAFTA trading part-
ners. As you are doing these exercises, ask yourself the following questions: 
• Have there been any changes in exports or trade balance since the inception of NAFTA?
• Is there a larger market available for business in North America?
• Is there greater competition forcing businesses to provide the best products and best prices 

for their goods?
• Has NAFTA been equally beneficial for all countries involved?
• Does the trade balance of a country tell the whole story of how effective NAFTA is?

Ultimately, you will have to decide if you think NAFTA is effective!

 

Step 1 Start ArcMap

 

a

 

Double-click the ArcMap icon on your computer’s desktop.
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b

 

If the ArcMap start-up dialog appears, click 

 

An existing map

 

 and click OK. Then go 
to step 2b. 

Step 2 Open the Region6.mxd file

 

a

 

In this exercise, a map document has been created for you. To open it, go to the File 
menu and choose 

 

Open

 

.

 

b

 

Navigate to the module folder (

 

C:\MapWorld9\Mod6

 

) and choose 

 

Region6.mxd

 

 
(or 

 

Region6

 

) from the list.

 

c

 

Click Open.

 

When the map document opens, you see a map of North America showing the three 
countries participating in NAFTA.
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Step 3 Examine the map and attribute table

 

a

 

Click the Identify tool, then click Canada on the map. 

 

b

 

Look at the attribute names in the Field column of the Identify Results window. 

 

c

 

Scroll down the list and answer the following questions.

 

(1) Which years does the layer contain data for?

(2) How many attributes are there for each year?

 

Field names with the word “to” in them represent the value of goods and services 
exported from one country to another. For example, the attribute 

 

1991 to US

 

 
represents the value of goods and services that a country exported 

 

to

 

 the 

 

United 
States

 

 in the year 1991. Field names with the abbreviation “TB” represent a 
country’s trade balance.

The values are expressed in millions of U.S. dollars. That means you have to 
multiply the number you see by 1,000,000 to get the actual dollar value.

 

(3) What was the value of goods and services exported from Canada to the United 
States in 1991?



 

Regional case study: Share and Share Alike

 

GIS investigation

 

MODULE 6

 

• HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

 

360

 

P
H
O
T
O

 

C

 

O
P
Y

 

d

 

Close the Identify Results window.

 

e

 

Right-click NAFTA Countries in the table of contents and choose Open Attribute Table.

 

(1) What is the name of the table?

(2) How many rows are there for each country on the map?

 

f

 

Click the gray box at the beginning of the United States row in the table.

Step 4 Relate another table to the layer table 

 

In this step you will open a second table that contains the trade data organized 
differently. You will relate the two tables together and then view the trading 
statistics in the tables and on a series of graphs.

 

a

 

Click the Source tab at the bottom of the table of contents. (Hint: If the Source tab is 
covered by the Attributes of NAFTA_Countries table, click the table’s title bar and drag 
the table out of the way.)

 

b Right-click NAFTA_Trading_Statistics in the table of contents and choose Open.

Note: The NAFTA_Trading_Statistics table is not listed on the Display 
tab because it is not a map layer. It is only listed on the Source tab.

c Make each table window smaller. Make sure that you can see all of the rows in the 
table as well as the Options button at the bottom. Arrange your windows so that you 
can see the map and both of the tables at the same time (Hint: Your ArcMap window 
can be small for this investigation.)

d Examine the NAFTA_Trading_Statistics table pictured below and answer the 
questions.

(1) How many rows are there for each country?

(2) What information is collected under the field titled “Item” for Canada?

(3) Describe in general terms the information collected in the field titled “Item.”

(4) How many years of data are represented in the table?
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In the next steps, you will relate the two tables by using common information to 
both tables (country names). 

e Right-click NAFTA Countries in the table of contents, point to Joins and Relates, and 
click Relate.

f In the first drop-down list in the Relate dialog, scroll down and choose CNTRY_NAME. 
Keep the default selections for steps 2 and 3. In step 4, replace the default name with 
Countries to Years. Click OK.

g Click the Options button in the Attributes of NAFTA Countries table and choose 
Related Tables, Countries to Years: NAFTA_Trading_Statistics.

What happens in the NAFTA Trading Statistics table?

h Use the Select Features tool to click Canada on the map.

What happens in the two tables and the map?

i Update the related rows by clicking the Options button in the Attributes of NAFTA 
Countries table and choosing Related Tables, Countries to Years: NAFTA_Trading_Statistics.

Next, you’ll see what happens when you make a selection in the related table.

j Select a row for Mexico in the Attributes of NAFTA_Trading_Statistics table.

What happens in the two tables and the map?

k Now click the Options button in the related table—the Attributes of NAFTA_Trading_
Statistics table—and choose Related Tables, Countries to Years: NAFTA_countries.

What have you observed about the way the NAFTA Trading Statistics table is tied to 
the NAFTA Countries attribute table and map layer?

l Click Selection in the Main menu in the ArcMap window and choose Clear Selected 
Features. All of the selections are cleared.
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Step 5 Examine export graphs

Now you will examine a graph of exports to Canada.

a Click the Tools menu, point to Graphs, and choose Exports to Canada.

The graph window actually contains three small graphs, one for each country.

b Enlarge the graph window slightly so you can read it more easily.

(1) Which country exported more goods and services to Canada—Mexico or the 
United States?

(2) Why is the graph empty in the space for Canada?

c Drag the graph window completely off the map and table windows.

d Using the Select Features tool, click Mexico on the map. Mexico is outlined in blue. 

What happened to the graph?

Because the graph is created from the data in the attribute table, it is tied to the 
map through the table. When you select a country on the map, only the data for 
that associated row in the table is displayed in the graph.

e Answer the questions below using the graph and tables.

(1) How many years of data are represented on the graph?

(2) What year does the first bar on the left represent?

(3) Compare the numbers on the y-axis with those in the two tables. Are the numbers 
on the graph in thousands, millions, or billions of dollars? (Hint: Remember that 
the Attributes of NAFTA Countries table values are in millions of dollars.)

(4) Looking at the graph, how would you describe the trend of Mexican exports to 
Canada over the 10-year period?

(5) What was the approximate value of Mexican exports to Canada in 1991? In 2000?

(6) Approximately how many times greater is the 2000 export figure than the 1991 
export figure?

f Close the Exports to Canada graph.

g Click the Tools menu and open the graph entitled Exports to U.S.

(1) How would you describe the trend of Mexican exports to the United States over 
the 10-year period?

(2) Approximately how many times greater is the 2000 export figure than the 1991 
export figure?

Note: Carefully observe the y-axis values of the graphs in this investiga-
tion. The height of a column may be the same on two different graphs, 
but it may represent very different dollar values.
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Step 6 Examine a trade balance graph

a Click the Tools menu and open the graph entitled Trade Balance with U.S. 

b This graph may cover up the first graph. Drag it below the first one so you can see 
both graphs at the same time.

Remember: Trade balance compares how much a country exports to a 
trading partner with how much it imports from the same partner.

c Use the Trade Balance with U.S. graph to answer the questions below.

(1) Did Mexico have a trade surplus or deficit with the United States for 1992?

(2) What was the approximate value of the trade balance for 1992? (Remember, the 
y-axis is in millions of dollars.)

(3) What was the first year that Mexico exported more to the United States than it 
imported from the United States?

(4) Describe the trend of Mexico’s trade balance with the United States over the 
10-year period.

d Click Canada on the map. Look at the Trade Balance graph again.

Did Canada have a deficit trade balance with the United States anytime during the 
10-year period?

e Click the map away from any country (anywhere in the yellow area) to clear the 
selection. Compare Mexico and Canada on the graph.

(1) In 1998, was Canada’s trade balance with the United States greater, smaller, or 
about the same as Mexico’s?

(2) In 2000, was Canada’s trade balance with the United States greater, smaller, or 
about the same as Mexico’s?

f Select Canada on the map, then click the Options menu in the Attributes of NAFTA 
Countries table and update the relate.

Referring to the Attributes of NAFTA_Trading_Statistics table, what was the exact 
value of Canada’s trade balance with the United States in 2000?

g Click the Selection menu in the ArcMap window and click Clear Selected Features.

Step 7 Change the look of a trade balance graph

a Close the table windows and the Exports to U.S. graph. (Keep open the Trade Balance 
with U.S. graph.)

b Click the Tools menu and open the graph entitled TB Mex.

TB Mex is a basic graph showing the Mexican trade balance data. In the next steps 
you will change the properties of this graph to give it the same appearance as the 
other trade balance graphs.

c Right-click the title bar of the TB Mex graph window and choose Properties.

d Arrange your windows so you can see the Graph Properties dialog and both of the 
graphs.
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You will begin by changing the graph title, adding a subtitle, and removing the 
graph legend.

e In the Appearance tab, make the following changes:

• Delete the existing title and type Trade Balance with Mexico.
• In the Sub title box, type All graphs cover the period 1991-2000, left to right. 
• Check the box to Label X Axis With. CNTRY_NAME should be the label field.
• Uncheck the Show Legend box.

f Click Apply. The TB Mex graph is updated.

Next you will add the grid lines and change the color of the title, subtitle, and 
background.

g Click the Advanced Options button on the Appearance tab of the Graph Properties 
dialog.
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h Click the Axis tab in the Advanced Options dialog. Choose the following settings, and 
then make sure your dialog looks like the one pictured below:

• Color of Axes = teal blue (the fourth color listed)
• Position = Left
• Check to Show grids
• Grid color = black

i Click the Background tab.

j Make sure that Graph Title is selected in the Apply To list. Then click the Text Color 
drop-down list and choose teal blue.

k Click Bottom Title in the Apply To list. Choose the teal blue text color again.

l Click Graph in the Apply To list and make the text color black.

m Click the Palette drop-down list. Scroll up and choose 128 Pastel.
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n Locate the Background list just above the Palette list (NOT the Background Color list to 
the left). Select light cyan blue by scrolling down about two-thirds of the way until you 
see a set of cyan blues and then bright pinks. Choose the second light cyan color above 
the bright pink. (This is the color that is used in the Trade Balance with U.S. graph.)

o Click OK in both open dialog windows.

The Trade Balance with Mexico graph now looks like the other trade balance 
graphs. You will use this graph later in step 8.

p Close the two graph windows.

q Ask your teacher if you should stop here and save this ArcMap map document. Follow 
your teacher’s instructions on how to rename the map document and where to save 
it. For example, you could rename it ABC_Region6 where ABC are your initials. To 
help you remember, write the new name you gave the project and where you saved 
it on the answer sheet.

If you do not need to save the project, proceed to step 8.

Step 8 Evaluate the effectiveness of NAFTA

In this lesson, you are looking at the level of trade among the NAFTA trading 
partners—Canada, Mexico, and the United States. You are also looking at changes 
in the level of trade among the three countries over time.

Remember, it is nearly impossible for any country to produce everything it needs to 
support its people. Countries must import (purchase) goods from other countries. 
One country’s imports are the other country’s exports. In this map document, you 
have no graphs for imports because you can figure out that information by looking 
at the export graphs.

For example, to find the United States’ imports from Canada, you switch the ques-
tion in your mind and look for Canada’s exports to the United States. You would 
find this information on the graph entitled Exports to United States.

To decide whether or not NAFTA is meeting its goals, you will need to further 
explore the data in the graphs and tables in the ArcMap map document. In this step, 
you will gather the information that you need to decide if you think NAFTA is effec-
tive. You may want to refer to the NAFTA objectives handout or the list of NAFTA 
goals you developed with your teacher at the beginning of the lesson. Remember 
these formulas as you examine the charts and answer the questions that follow:

Exports – Imports = Trade Balance 

Trade Balance:
Exports > Imports = Trade Surplus 
Imports > Exports = Trade Deficit 
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a Go to the Tools menu and open the three export graphs. Arrange them so they are 
not overlapping and you can compare them.

b Use the graphs to find the value of exports between each set of countries for the year 
2000. Write the information in the table on your answer sheet.

c Add the export values together for each pair of countries (for example, United States 
to Mexico plus Mexico to United States) and write that number in the Total Volume 
Between Partners column.

d Rank the trading partners by the overall volume of trade between the two countries. 
Use 1 for the partners trading the most and 3 for the partners trading the least.

(1) Do you think that NAFTA had a positive (+), negative (–), or neutral (n) effect on 
trade volume between each set of partner countries?

(2) Do you think that any one of these three countries benefited more than the 
other two by NAFTA? If so, which country? Explain your answer.

e Close the three graph windows.

f Go to the Tools menu and open the three Trade Balance graphs. Arrange them so you 
can compare them.

Remember that most countries prefer to export a higher volume and dollar value of 
goods than they import, but either a large trade surplus or large trade deficit may 
negatively affect a country’s overall economic health.

g Look at the Trade Balance with Canada graph.

(1) What country has a healthier trade balance with Canada—Mexico or the United 
States?

(2) On what graph do you find a set of bars that looks like a mirror image of those 
for the U.S. trade balance with Canada?

h Compare the trade balance graphs.

(1) What country had the most dramatic change for the better after NAFTA came 
into being? (Remember, NAFTA went into effect in 1994.)

(2) Estimate the U.S. trade deficit with Canada and Mexico for 1999 and 2000. Express 
the values in billions of dollars, using round numbers that you estimate from the 
graphs. Write the answers in the space provided.

(3) Did the U.S. combined trade balance get better or worse between 1999 and 
2000? By how much?

i Close the three graph windows.

Step 9 Create and print a layout

In this step you will create a layout that presents the information about the U.S. 
trade balance and exports to Canada. The layout will include the NAFTA countries 
map and two graphs: Exports to Canada and Trade Balance with Canada. Later, in 
the assessment, you will use the techniques you learn to create a layout showing 
the results of your evaluation of NAFTA.

a Click the Layout View button.

b Maximize your ArcMap window so that it fills your screen. If your Layout toolbar is 
floating, dock it above the view or in your preferred location.



Regional case study: Share and Share Alike GIS investigation

MODULE 6 • HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

368

P
H
O
T
O
C
O
P
Y

c Click the Zoom Whole Page button on the Layout toolbar to make the layout fill the 
view.

The layout looks like a piece of paper. The layout already has a map, title, north 
arrow, legend, and scale bar. Before adding the graphs, you will make space for 
them by slightly reducing the size of the map.

d Click the Fixed Zoom Out button on the Tools toolbar once to reduce the size of North 
America.

Next you will add the two graphs.

e Click the Tools menu, point to Graphs, and then click Manage to display the Graph 
Manager.

f Select Exports to Canada in the list and then click the Show on Layout button.

The graph is added to the middle of the layout. 

g Repeat the procedure to show the Trade Balance with Canada graph on the layout.

h Click Close to close the Graph Manager.

You will arrange the two graphs on the left side of the layout. You will also make 
the map a little smaller so that it better fits the space on the right.

i Click the Trade Balance with Canada graph using the Select Elements tool. Drag the 
graph to the upper left of the layout, under the title.

j Click the Exports to Canada graph to activate it. Then click and drag it to a position 
below the first graph.
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k Use the Pan tool on the Tools toolbar to move North America slightly to the right—
center it between the graphs and the legend.

When you are satisfied with the look of your layout, go on to the next step. You will 
add your name and the date to the layout.

l Click the New Text tool in the Draw toolbar. Click in the yellow space underneath the 
graphs to insert a piece of text.

m Type your name, a comma, and today’s date, and then press the Enter key on your 
keyboard.

n Drag the text down to the lower left corner of the layout, just inside the map neat 
line. When you are finished, click anywhere in the white space outside the layout to 
unselect the text.

Finally, you need to focus the graphs on the United States to reflect U.S. trade with 
Canada.

o Click the Select Features tool and click the United States on the map.

The graphs change to focus on U.S. data.

p From the File menu, select Print.

q Check with your teacher to be sure the correct printer is selected. Click OK to print 
your layout.

Step 10 Exit ArcMap

In this exercise, you used ArcMap tables, graphs, and a map to explore trade data 
for the three North American countries. After analyzing this data, you created a 
layout to present some of the information.

a Ask your teacher for instructions on where to save this map document and on how to 
rename it. Save it according to your teacher’s instructions.

b If you are not going to save the map document, exit ArcMap by choosing Exit from the 
File menu. When asked if you want to save changes to the map document, click No.
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NAME __________________________________________________ DATE ________________________

Student answer sheet
Module 6
Human Geography III: Economic Geography

Regional case study: Share and Share Alike

Step 3 Examine the map and attribute table
c-1 Which years does the layer contain data for? ______________ to _____________

c-2 How many attributes are there for each year? _______________________________________________

c-3 What was the value of goods and services exported from Canada to the United States in 1991?
$ __________________________________________________________________________________

e-1 What is the name of the table? ___________________________________________________________

e-2 How many rows are there for each country on the map? ______________________________________

Step 4 Relate another table to the layer table
d-1 How many rows are there for each country? ________________________________________________

d-2 What information is collected under the field title “Item” for Canada?
____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

d-3 Describe in general terms the information collected in the field titled “item.”
____________________________________________________________________________________

____________________________________________________________________________________

d-4 How many years of data are represented in the table? ________________________________________

g What happens in the NAFTA_Trading Statistics table?
____________________________________________________________________________________

____________________________________________________________________________________

h What happens in the two tables and the map?
____________________________________________________________________________________

____________________________________________________________________________________

j What happens in the two tables and the map?
____________________________________________________________________________________

____________________________________________________________________________________
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k What have you observed about the way the NAFTA Trading Statistics table is tied to the NAFTA 
Countries attribute table and map layer?
___________________________________________________________________________________

___________________________________________________________________________________

Step 5 Examine export graphs
b-1 Which country exported more goods and services to Canada—Mexico or the United States?

___________________________________________________________________________________

b-2 Why is the graph empty in the space for Canada?
___________________________________________________________________________________

___________________________________________________________________________________

d What happened to the graph?
___________________________________________________________________________________

___________________________________________________________________________________

e-1 How many years of data are represented on the graph? _______________________________________

e-2 What year does the first bar on the left represent? ____________________________________________

e-3 Compare the numbers on the y-axis with those in the two tables. Are the numbers on the graph in 
thousands, millions, or billions of dollars?
___________________________________________________________________________________

e-4 Looking at the graph, how would you describe the trend of Mexican exports to Canada over the 
10-year period?
___________________________________________________________________________________

e-5 What was the approximate value of Mexican exports to Canada in 1991?
___________________________________________________________________________________

In 2000?________________________________________________________________________________

e-6 Approximately how many times greater is the 2000 export figure than the 1991 export figure?
___________________________________________________________________________________

g-1 How would you describe the trend of Mexican exports to the United States over the 10-year period?
___________________________________________________________________________________

g-2 Approximately how many times greater is the 2000 export figure than the 1991 export figure?
___________________________________________________________________________________
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Step 6 Examine a trade balance graph
c-1 Did Mexico have a trade surplus or deficit with the United States for 1992? ______________________

c-2 What was the approximate value of the trade balance for 1992? (Remember, the y-axis is in millions of 
dollars.)
____________________________________________________________________________________

c-3 What was the first year that Mexico exported more to the United States than it imported from the 
United States?
____________________________________________________________________________________

c-4 Describe the trend of Mexico’s trade balance with the United States over the 10-year period.
____________________________________________________________________________________

____________________________________________________________________________________

d Did Canada have a deficit trade balance with the United States anytime during the 10-year period?
____________________________________________________________________________________

e-1 In 1998, was Canada’s trade balance with the United States greater, smaller, or about the same as 
Mexico’s?
____________________________________________________________________________________

e-2 In 2000, was Canada’s trade balance with the United States greater, smaller, or about the same as 
Mexico’s?
____________________________________________________________________________________

f Referring to the Attributes of NAFTA_Trading_Statistics table, what was the exact value of Canada’s 
trade balance with the United States in 2000?
____________________________________________________________________________________

Step 7 Change the look of a trade balance graph
q Write the new name you gave the map document and where you saved it.

______________________________________ ______________________________________
(Name of map document. (Navigation path to where map document is saved.

For example: ABC_Region6.mxd) For example: C:\Student\ABC)
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Step 8 Evaluate the effectiveness of NAFTA
b Use the graphs to find the value of exports between each set of countries for the year 2000. Write the 

information in the table below. 

c Add the export values together for each pair of countries (for example, United States to Mexico plus 
Mexico to United States) and write that number in the Total Volume Between Partners column.

d Rank the trading partners by the overall volume of trade between the two countries. Use 1 for the 
partners trading the most and 3 for the partners trading the least.
United States–Mexico: ________

United States–Canada: ________

Canada–Mexico: ________

d-1 Do you think that NAFTA had a positive (+), negative (–), or neutral (n) effect on trade volume between 
each set of partner countries? 
United States–Mexico: ________

United States–Canada: ________

Canada–Mexico: ________

d-2 Do you think that any one of these three countries benefited more than the other two by NAFTA? If so, 
which country? Explain your answer.
___________________________________________________________________________________

___________________________________________________________________________________

___________________________________________________________________________________

g-1 What country has a healthier trade balance with Canada—Mexico or the Untied States?
___________________________________________________________________________________

g-2 On what graph do you find a set of bars that looks like a mirror image of those for the U.S. trade 
balance with Canada?
___________________________________________________________________________________

h-1 What country had the most dramatic change for the better after NAFTA came into being? (Remember, 
NAFTA went into effect in 1994.)
___________________________________________________________________________________

DIRECTION OF EXPORT FLOW
VALUE OF EXPORTS

(MILLION $)
TOTAL VOLUME BETWEEN PARTNERS 

(MILLION $)

United States to Mexico

Mexico to United States

United States to Canada

Canada to United States

Canada to Mexico

Mexico to Canada
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h-2 Estimate the U.S. trade deficit with Canada and Mexico for 1999 and 2000. Express the values in 
billions of dollars, using round numbers that you estimate from the graphs.

h-3 Did the U.S. combined trade balance get better or worse between 1999 and 2000? ________________

By how much? _________________________________________________________________________

1999 ($ BILLION) 2000 ($ BILLION)

U.S. trade balance with Mexico

U.S. trade balance with Canada

Combined deficit (total)
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Share and Share Alike
Middle school assessment
1 Using the 10 years of export and trade balance data you have for the NAFTA trading partners, 

Canada, Mexico, and the United States, make a determination if you think that NAFTA has 
been effective, marginally effective, or ineffective and whether you think NAFTA should 
continue or not.
Remember that there are several factors that you can use in drawing your conclusions. You 
have looked at several of those factors during this lesson. For instance, you can compare the 
exports of each country as well as look at each country’s trade balances. Refer back to the 
NAFTA Objectives handout to remind yourself of the original intent of NAFTA.

2 To display your findings, create a layout in ArcMap that graphically displays your conclusion. 
Use the layout in the Region6_Assessment map document that has already been started for 
you. You may rearrange and resize the existing layout components and add your own. Your 
final layout should include the following components:
(a) Title 
(b) Map
(c) Map legend
(d) Orientation (north arrow or compass rose)
(e) At least two charts
(f) Text labels or descriptions
(g) Author (your name)
(h) Today’s date

3 Present your layout to the class as evidence for your conclusion on NAFTA’s effectiveness.
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This is a four-point rubric based on the National Standards for Geographic Education. The “Mastery” level meets the target objective for 
grades 5–8.

STANDARD EXEMPLARY MASTERY INTRODUCTORY DOES NOT MEET REQUIREMENTS

The student knows and 
understands how to make 
and use maps, globes, 
graphs, charts, models, 
and databases to analyze 
spatial distributions and 
patterns.

Creates a layout using GIS with 
eight or more components includ-
ing several maps and charts that 
illustrate the effectiveness of 
NAFTA.

Creates a layout using GIS with 
eight components including a 
map and minimum of two charts.

Creates a layout using GIS with 
most of the eight specified com-
ponents including a map and at 
least one chart.

Creates a layout using GIS with 
some of the eight specified com-
ponents including a map.

The student knows and 
understands the basis for 
global interdependence.

Layout shows a clear understand-
ing of the concepts of balance of 
trade for NAFTA trading partners 
through multiple charts and maps.

Layout includes charts and maps 
showing an understanding of the 
concept of balance of trade for 
NAFTA trading partners.

Layout includes charts and maps 
showing some understanding of 
the concept of balance of trade 
for NAFTA trading partners.

Layout includes chart and or map 
showing trade partners, but does 
not illustrate an understanding of 
balance of trade.

The student knows and 
understands how coopera-
tion and conflict among 
people contribute to eco-
nomic and social divisions 
of Earth’s surface.

Presents a logical argument to 
his/her conclusions on the effec-
tiveness of NAFTA using a variety 
of resources to support his/her 
findings including, but not limited 
to, data and maps.

Presents a logical argument to 
his/her conclusions on the effec-
tiveness of NAFTA using data and 
maps to support his/her ideas.

Describes conclusions on the 
effectiveness of NAFTA and pro-
vides data and maps, but cannot 
provide ample argument or 
evidence.

Identifies NAFTA participants and 
trading partners, but does not 
present any personal conclusions 
as to its effectiveness.



Regional case study: Share and Share Alike Student assessment: High school

MODULE 6 • HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

378

P
H
O
T
O
C
O
P
Y

NAME ___________________________________________________ DATE _________________________

Share and Share Alike
High school assessment
1 Using the 10 years of export and trade balance data you have for the NAFTA trading partners, 

Canada, Mexico, and the United States, make a determination if you think that NAFTA has 
been effective, marginally effective, or ineffective and whether you think NAFTA should 
continue or not.
Remember that there are several factors that you can use in drawing your conclusions. You 
have looked at several of those factors during this lesson. For instance, you can compare the 
exports of each country as well as look at each country’s trade balances. Refer back to the 
NAFTA objectives handout to remind yourself of the original intent of NAFTA.

2 To display your findings, create a layout in ArcMap that graphically displays your conclusion. 
Use the layout in the Region6_Assessment map document that has already been started for 
you. You may rearrange and resize the existing layout components and add your own. Your 
final layout should include the following components:
(a) Title 
(b) Map
(c) Map legend
(d) Orientation (north arrow or compass rose)
(e) At least two charts
(f) Text labels or descriptions
(g) Author (your name)
(h) Today’s date

3 Present your layout to the class as evidence for your conclusion on NAFTA’s effectiveness.

4 Compose a paragraph describing how you would change the NAFTA agreement to improve 
or enhance future trading results for all three countries. Include specific reasons why you 
believe your changes to NAFTA would be effective.
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This is a four-point rubric based on the National Standards for Geographic Education. The “Mastery” level meets the target objective for 
grades 9–12.

STANDARD EXEMPLARY MASTERY INTRODUCTORY DOES NOT MEET REQUIREMENTS

The student knows and 
understands how to use 
geographic representa-
tions and tools to analyze, 
explain, and solve geo-
graphic problems.

Creates a layout using GIS with 
eight or more components includ-
ing several maps and charts that 
illustrate the effectiveness of 
NAFTA.

Creates a layout using GIS with 
eight components including a 
map and minimum of two charts 
that illustrates the effectiveness of 
NAFTA.

Creates a layout using GIS with 
most of the eight specified com-
ponents including a map and at 
least one chart that illustrate the 
effectiveness of NAFTA.

Creates a layout using GIS with 
some of the eight specified com-
ponents including a map that 
illustrates the effectiveness of 
NAFTA.

The student knows and 
understands the increas-
ing economic interdepen-
dence of the world’s 
countries.

Composes a brief essay that 
defines specific improvements to 
the NAFTA agreement that will 
benefit future trading for all three 
countries. Provides examples to 
illustrate these ideas.

Composes a paragraph that 
defines specific improvements to 
the NAFTA agreement that will 
benefit future trading for all three 
countries.

Composes a paragraph that lists 
ideas for improvement to the 
NAFTA agreement, but the 
improvements may not benefit all 
parties.

Lists ideas for improvement to the 
NAFTA agreement, but does not 
define how these improvements 
will enhance future trading.

The student knows and 
understands why and how 
cooperation and conflict 
are involved in shaping 
the distribution of social, 
political, and economic 
spaces on Earth at differ-
ent scales.

Presents a logical argument to 
his/her conclusions on the effec-
tiveness of NAFTA at a local, 
regional, and global level using a 
variety of resources to support his/
her findings including, but not 
limited to, data and maps.

Presents a logical argument to 
his/her conclusions on the effec-
tiveness of NAFTA at a local, 
regional, and global level using 
data and maps to support his/her 
ideas.

Describes conclusions on the 
effectiveness of NAFTA at a local, 
regional, and global level, but 
cannot provide ample argument 
or evidence.

Identifies NAFTA participants and 
trading partners, but does not 
present any personal conclusions 
as to its effectiveness.





 

Live, Work, and Play

 

An advanced investigation

 

Lesson overview

 

Students will use the Internet to acquire the most recent data on employment in 
California. By exploring this data through a GIS, they will construct a thematic 
map for California counties that displays population, number of jobs in the finance 
field, and average wage data, then perform a complex query and create a map that 
illustrates their results. Students will be learning how to examine data to choose 
a place to live that satisfies a set of criteria.

 

Estimated time

 

Two to three 45-minute class periods

 

Materials

 

✔

 

Student handouts from this lesson to be copied:
• Live, Work, and Play worksheet (page 384)
• GIS Investigation sheets (pages 385 to 394)

 

Standards and
objectives

 

National geography standards

Objectives

 

The student is able to:
• Use the Internet to locate data for recent economic activity.

• Use a GIS to map data acquired from the Internet.

• Thematically map various data to select an appropriate place to live.

 

GEOGRAPHY STANDARD MIDDLE SCHOOL HIGH SCHOOL

 

1

 

How to use maps and other geo-
graphic representations, tools, 
and technologies to acquire, 
process, and report informa-
tion from a spatial perspective

The student understands how to 
make and use maps, globes, graphs, 
charts, models, and databases to 
analyze spatial distributions and 
patterns.

The student understands how to 
use geographic representations and 
tools to analyze, explain, and solve 
geographic problems.

 

12

 

The processes, patterns, and 
functions of human settlement

The student understands the causes 
and consequences of urbanization.

The student understands the evolving 
forms of present-day urban areas.

 

18

 

How to apply geography to 
interpret the present and plan 
for the future

The student understands how vary-
ing points of view on geographic 
context influence plans for change.

The student understands how to 
use geographic knowledge, skills, 
and perspectives to analyze prob-
lems and make decisions.
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GIS skills and tools

 

• Locate data on the Internet and prepare it in a comma-delimited file 

• Add tables to a map document

• Join tables

• Select features by multiple attributes

• Select a county according to a number of criteria

• Create a layout

• Print a presentation-style map

For more on geographic inquiry and these steps, see Geographic Inquiry and GIS 
(pages xxiii to xxv).

 

Teacher notes

 

Lesson
introduction

 

Open a class discussion with the following prompts:
• Business owners frequently use GIS to select a suitable site for a new business 

location.
• Individuals can also use GIS to decide where they would like to live, work, and 

spend their leisure time by looking for areas that have various characteristics, 
such as affordable housing, employment opportunities, and recreational areas.

• What criteria are important to students when they think about where they 
would like to live after they graduate from high school or college and enter 
adulthood?

Explain to your students that they will use the Internet to find data on recent 
economic activity. They will use a GIS to map economic data they find and will 
analyze the data to locate the best place to live, work, and play. This GIS Investi-
gation will require students to work independently, with little guidance.
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Student activity Before completing this lesson with students, we recommend that you 
complete it as well. Doing so will allow you to modify the activity to 
accommodate the specific needs of your students.

 

Distribute this lesson’s GIS Investigation sheets and the Live, Work, and Play 
Worksheet. Students should fill out the worksheet, identifying the criteria they 
consider the most important in choosing a place to live, then follow the guidelines 
to retrieve county economic data from the Internet. They will edit the data, add 
the data to ArcMap, and export the data to a geodatabase table. Then students 
will use the data to create thematic maps that display concentrations of jobs and 
wages, and analyze the maps to find areas with desirable characteristics (as 
listed on the worksheet).

 

Teacher Tip: In this activity, students will download and edit data. They 
will export the edited data to a geodatabase table. This action results in 
permanent changes to the data. In order for this to work properly, each 
student must have their own copy of the Mod6 folder.

Conclusion

 

Engage students in a discussion of the patterns they discovered as they mapped 
different economic criteria. Were they able to find a place to live that satisfied 

 

all

 

 
of the criteria they had? Could they add more criteria? Could they use this same 
method to download data for other states and broaden the search area (e.g., 
including Washington and Oregon)? How might site analysis be useful for 
businesses?

 

Assessment

 

The last step of the GIS Investigation asks students to perform their own multiple-
attribute query on where to live, and create a layout of their results. In addition to 

 

the map, you may wish to ask students to submit a written report that summa-

 

rizes the process they went through in selecting an optimal living site and explains 

 

their query of the data. A written report could answer any or all of the following 
questions:
• What steps were involved in the query process each student went through to 

make their site selection?
• Were they surprised at the results they got when they mapped the various 

criteria? Why or why not?
• Was there an alternate site that might have been as acceptable as the first site 

chosen? Why or why not?

 

Note: Due to the independent nature of this lesson, there is no supplied 
assessment rubric. You are free to design assessment rubrics that meet the 
needs of your specific adaptation.

Extensions

 

• Ask students to broaden their search area to other states. Download economic 
data for other states from the Bureau of Economic Analysis Web site and 
perform the same analysis. Students should note any changes they see.

• Have students query more fields in the CA counties table to narrow their 
search. They can explore, for example, median rent, median house values, and 
the percentage of residents who are married.

• Have students download employment data for an industry that interests them 
and perform a query based on their individual priorities.

• Check out the Resources by Module section of this book’s companion Web site 

 

(www.esri.com/mappingourworld)

 

 for print, media, and 

 

Internet resources on 
the topics of employment data and demographics.
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NAME ___________________________________________________ DATE _________________________

 

Live, Work, and Play worksheet

 

Imagine: You have just graduated from college with a degree in finance. You want to move to 
California, but you don’t know which county would be best for you. You need to find a good job 
in the finance industry (banking, investments, insurance, or real estate). You know that salary 
is important (after all, you would like to start paying off your student loans as soon as possible), 
but you also know there are many other things to consider when deciding where to live and 
work. For example, you might want to consider the cost of housing, the length of your commute, 
and what you’ll do in your free time (do you want to be near the beach, the mountains, a city 
with good nightlife?). 

To start your investigation of good, better, and best places to live, complete the table below. For 
each category, designate it as a Very Important, Average, or Not Important criterion for deter-
mining where you want to live. 

 

LAYERS AVAILABLE VERY IMPORTANT AVERAGE NOT IMPORTANT

 

Percentage of people 
ages 18–29

Number of finance 
jobs available

Average wage
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NAME __________________________________________________ DATE ________________________

 

Live, Work, and Play

 

An advanced investigation

 

Note: Due to the dynamic nature of the Internet, the URLs listed in this 
lesson may have changed, and the graphics shown below may be out of 
date. If the URLs do not work, refer to this book’s Web site for an 
updated link: www.esri.com/mappingourworld.

 

Answer all questions on the student answer sheet handout

 

Now that you have rated the importance of different criteria in determining where you want to 
live, you will download employment data from the Internet and use ArcMap to find places that 
meet your criteria. (Make sure that you have completed the Live, Work, and Play worksheet 
provided by your teacher before beginning this part of the activity.)

 

Step 1 Locate economic data on the World Wide Web

 

The World Wide Web is a great source to find geographic data. In this step, you will 
go to the Bureau of Economic Analysis (BEA) Web site to find economic data.

 

a

 

Open your Web browser to the BEA U.S. Economic Accounts page at 

 

www.bea.doc.gov

 

.

 

b

 

Under Regional, click 

 

State and Local Personal Income

 

.

 

c

 

Under Local area annual estimates, click the link titled 

 

Interactive tables - view or 
download specific data

 

.

 

d

 

Under Step 1, choose 

 

Detailed income and employment tables by NAICS 
industry, 2001-2002 (CA05 and CA25)

 

.

 

e

 

Under Step 2, click 

 

CA25N - Total full-time and part-time employment by 
industry

 

.
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f

 

Under Step 3, click 

 

California

 

 for the state, then click the arrow button. 

 

g

 

Click the Display button to see a report for all of California. 

 

h

 

Scroll down the industry classifications and click the code 

 

1000

 

. A table displays 
showing the number of people employed in finance and insurance jobs per county or 
metropolitan area (MSA) in California.

Step 2 Download data and prepare it for ArcGIS

 

Before you can see a map of this data in ArcMap, you need to save it to your computer

 

 
and modify it so that ArcGIS can understand it. The modifications are done in a 
text editor program.

 

a

 

Click the Download Data button. 
The file is in comma separated values format (.csv). Choose to save the file.

 

b

 

Save the file in your module 6 data folder (

 

C:\MapWorld9\Mod6\Data

 

) and rename 
it 

 

ABC_finance.csv

 

, where 

 

ABC

 

 are your initials.

 

c

 

Open a text editor such as WordPad or Notepad. Open the ABC_finance.csv file you 
just saved. (Hint: Select All Files in the Files of type drop-down list to see the .csv file.) 
The data appears in your new document.

 

For example:
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d

 

Make the following changes in the first line of text:

 

•

 

Replace "Finance and insurance" with 

 

"Finance"

 

. (Keep the quotation marks.)

 

•

 

Change "2001" to 

 

Fin_2001

 

 and change "2002" to 

 

Fin_2002

 

. (Omit the quotation 
marks.)

 

Note: Fields with quotation marks will be defined as text. Fields without

 

 
quotation marks will be defined as numeric. Ignore the end-of-line 
symbols and quotation marks at the end of each line.

e

 

Narrow the table window until most lines have data for a single county. (Click and 
drag the right edge of the window.)

 

f

 

Use the Find and Replace function to find all "(D)" and replace them with 

 

"–99"

 

.

 

Consult the graphic below to make sure you made all the necessary changes.

The data you saved includes statistics for counties and metropolitan areas, but you 
need only the county statistics.

 

g

 

Delete all the data after Yuba County; it occurs approximately halfway through the 
file. (This is metro area data that you do not need.) The last line in your file now 
should read "1000", "06115", "Yuba",431,432". See example below:

 

h

 

Save the file.

 

i

 

Minimize the text editor program and your Web browser. You will use them later to 
download additional data in step 5.

 

Now that your data is in a format that ArcGIS can read, you will bring the data 
into ArcMap and map it.
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Step 3 Start ArcMap and add your data

 

a

 

Start ArcMap.

 

b

 

Open the 

 

Adv6.mxd

 

 (or 

 

Adv6

 

) map document from your module folder 
(

 

C:\MapWorld9\Mod6\Adv6.mxd

 

).

 

When the map document opens, you see a map with two layers turned on (Population

 

 
Age 18 - 29 and CA Counties).

 

c

 

Click the Add Data button and navigate to the location of 

 

ABC_finance.csv

 

, select it, 
and click Add.

 

d

 

Open the table from the Source tab and check it to make sure the fields and rows look 
correct and contain data.

 

e

 

Close the table.

 

Next, you will export the table to the California.mdb geodatabase.

 

f

 

Right-click ABC_finance.csv in the table of contents, point to Data, and click Export.

 

g

 

Click the Output table Browse button. Select Personal Geodatabase tables in the Save 
as type drop-down list. Type finance for the table name. Then navigate to the 
California geodatabase (C:\MapWorld9\Mod6\Data\California.mdb).
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h Click Save. Then click OK in the Export Data dialog. Click Yes to add the new table 
your map document.

i Right-click the ABC_finance.csv table and click Remove. You won’t be using this version 
of the table.

You will join the new geodatabase table to the attribute table of the CA Counties 
layer so that you can map the finance data.

j Right-click the CA Counties layer, point to Joins and Relates, and click Join.

k In the Join Data dialog, choose to Join attributes from a table. Choose FIPS as the field 
to base the join on. The next two boxes should be filled in automatically with finance 
and FIPS.

l Click OK. Click Yes if you receive a message about indexing the table.

m Open the CA Counties layer attribute table.

n Scroll to the right and notice that the finance fields appear at the end of the table. 
(These are Finance, FIPS, AreaName, Fin_2001, and Fin_2002.) Close the table.

In the next step, you will classify the CA Counties layer so you can thematically 
map the finance employment data you retrieved from the Internet.

Step 4 Thematically map finance employment data

a Click the Display tab in the table of contents. Turn off the Population Age 18 - 29 
layer.

b Right-click CA Counties and choose Copy. Click the Paste button to paste a copy of the 
CA Counties layer.

c Open the Properties dialog for the copied layer. Click the General tab and name the 
layer Number of Finance Jobs. 

d In the Symbology tab, choose Quantities, Graduated colors. For Value field, scroll to 
the end of the list and click finance.Fin_2002. Choose an orange or brown color ramp.

The value field (Fin_2002) represents the number of finance jobs for each county in 
California in 2002. By default, ArcMap has divided the number of finance jobs into 
five groups.
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Some counties have no data available. In such cases, the Fin_2002 field has a value 
of –99. Because this number is a code and not a measurement of the number of jobs, 
counties with a value of –99 need to be excluded from the categories you just 
created.

e Click the Classify button. In the next dialog, click the Exclusion button.

f In the Query tab of the Data Exclusion Properties dialog, create the following expression 
to define the counties you want to exclude: [finance.Fin_2002] = –99].

g Click the Legend tab and check Show symbol for excluded data. Choose a 30% gray 
symbol and label the class No Data. Click OK.

h Look at the histogram (graph) in the Classification dialog. 

The histogram shows the number of jobs on the x-axis (bottom) and the number of 
counties on the y-axis (side). The gray bars show how many counties have a particu-
lar number of jobs. The blue vertical lines show where the data is broken into classes.

i Change the classification method to Quantile and notice how the class breaks in the 
histogram change.

The “Quantile” method groups the counties so that each class has approximately the 
same number of counties. California has 58 counties in total with no data values 
data for two of them, leaving 56 counties with employment data for 2002. There-
fore, each of the five classes has approximately 11 counties. 

j Click OK in the Classification dialog.

The Symbology tab updates the list of five colored symbols, ranges, and labels.

k Change the labels for the five classes to the following phrases:

l Click OK to update the map.

m Save your map document according to your teacher’s instructions. We recommend 
that you save it in your Mod6 folder and rename it ABC_Adv6 where ABC are your 
initials.

n Look at the Finance jobs map. Where are the counties with a high number of finance 
jobs? You will refer back to this map after you’ve downloaded average wage data for 
the California counties.
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Step 5 Download average wage data for California counties

Now you will go back to the BEA Web site and retrieve data on average wages for 
California counties. Then you will add the data to ArcMap and the California 
geodatabase.

a Restore your Web browser and go to the BEA economic accounts page at 
www.bea.doc.gov.

b Under Regional, click State and Local Personal Income.

c Under Local area annual estimates, click the link titled Interactive tables - view or 
download specific data.

d Under Step 1, choose Wage and salary summary estimates (CA34).

e Under Step 2, click Average wage per job. Then choose California for the state 
and leave 2002 and 2001 for the years.

f Click the Display button to see a report for all of California.

g Click the Download Data button. Save the file as a comma separated values file (.csv) 
and rename it ABC_wage.csv, where ABC are your initials. Save it in a folder your 
teacher specifies.

Step 6 Prepare average wage data for ArcGIS

a Make the following edits to the file you just saved:

• Replace the long title "Average wage per job <sup1/</sup>" in the first line of the 
file with the word "Wage". (Keep the quotes.)

• Replace the double quotes and the years "2001" and "2002" with AvWage2001 
and AvWage2002. (Omit the quotes here.)

• Replace any "(D)" with "–99". (Note: Your data may not have any "(D)" values.)

b Delete everything after the Yuba County data.

c Save the file and exit the text editor program.
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Step 7 Add average wage data to ArcMap

a Repeat steps 3c–3i above to add the new ABC_wage.csv table to your map document 
and export it to the California geodatabase. Name the new table wage.

b Repeat steps 3j–3l above to join the wage table to the CA Counties table. (Note: You 
will need to use ca_counties.FIPS as the first join field, wage as the table, and FIPS as 
the second join field.)

c Click the Display tab in the table of contents. Then copy and paste the CA Counties 
layer.

Step 8 Thematically map California average wage data

a Double-click the new CA Counties layer to open the Layer Properties dialog. Rename 
the layer Average Wages in the General tab.

b Click the Symbology tab. Symbolize the layer with graduated colors using 
wage.AvWage2002 for the value field. Choose a color ramp that is different from 
the ones used for the other layers.

c Classify the data using the Defined Interval method. Type 10000 for the Interval Size 
and click OK in the Classification dialog.

This places the class breaks at even intervals of ten thousand (30,000, 40,000, etc.). 
Because the values represent dollars, you will format the labels as currency.

d Right-click anywhere in the white space in the symbol box and choose Format Labels. 
Choose the Currency format and click OK.

e Click OK in the Layer Properties dialog.

f Save your map document.

Step 9 Query the data

With population data, number of finance jobs data, and average wage data, you will 
perform a query to narrow down the counties where you could live in California. 
For the purpose of this exercise, you will perform an example query with detailed 
instructions. In step 10, you will perform your own query, using the preferences you 
made on your worksheet.

a Look at the different layers by turning them on and off. Try to visually identify a couple 
of counties that appear to meet the criteria you identified earlier.

Now you will perform a query. For this example query, assume that the number of 
people aged 18–29 years old is an important criterion, followed by number of finance 
jobs, and then average wage. Because this is countywide data, it’s important to take 
that into consideration when you develop the query.



GIS investigation Advanced investigation: Live, Work, and Play

MODULE 6 • HUMAN GEOGRAPHY III: ECONOMIC GEOGRAPHY

393

P
H
O
T
O
C
O
P
Y

b Turn off all layers except CA Counties.

c Click Selection on the Main menu and choose Select by Attributes.

d Choose CA Counties from the Layer list at the top of the Select by Attributes dialog. 
Choose “Create a new selection” for the method.

e For Fields, scroll down and to the right and double-click ca_counties.AGE_18_29. 

The 18- to 29-year-old population in California ranges from 203 in one county to 
1,988,668 in another. Because you want to eliminate counties with a low popula-
tion in this age group, you are going to query for counties with an 18- to 29-year-old 
population size of 10,000 or more.

f Click the greater than or equal to button, and then type 10000 in the query box.

g Verify your query and then click Apply. Move the Select By Attributes dialog so you 
can see all the counties in California with an 18- to 29-year-old population of 10,000 
or more.

h Click the Selection tab below the table of contents. Take note of how many counties 
are selected (38).

Now you will search for counties with many finance jobs as well as many people 
aged 18–29. This might narrow the list of places you would consider living, because 
some of the counties selected in your first query might have few finance jobs. You 
are going to query for counties with 5,000 or more finance jobs.

i In the Select By Attributes dialog, change Method to “Select from current selection.”

j Click the Clear button.

k Create the following new query statement: finance.Fin_2002 >= 5000. Verify the 
query statement and then click Apply.

The number of selected counties has decreased. There are now 22 selected counties 
that have a population aged 18–29 years of 10,000 or greater and more than 5,000 
finance jobs available. Now you will add average wage data to your search. These 
numbers reflect annual salary in dollars. In this example, you will query for coun-
ties with an average salary of $35,000 or more.

l Clear the current query statement and make a new one where AvWage2002 is greater 
than or equal to 35000. Select these features from the current selection.
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The number of selected counties has decreased significantly.

m Close the Select by Attributes dialog.

n Click the Display tab. Open the CA Counties layer attribute table and click the Selected 
button at the bottom of the table.

The 13 counties that meet all the criteria you used are highlighted in blue.

o Look at the map and ask yourself the following questions: Are the selected counties 
the ones you identified in step 9a? Do you know anything else about those counties 
that would make them an attractive place to live?

Step 10 Perform your own query and map your observations

a Use the instructions in step 9 and the worksheet you completed at the beginning of 
the GIS Investigation to create your own query of CA counties. Be sure to record the 
criteria you used for your query. You will need to include that information in your 
layout.

b After you’ve performed your query, prepare your map to look the way you want it to 
look in a layout.

c Create a layout and title it Live, Work and Play - Your Name. For example, Live, 
Work and Play - Joanna Smith would be an appropriate title for a map. 

Include the following items in your layout:
• Title
• Legend
• List of criteria used for query
• The Attributes of CA Counties table, displaying the results of your query
• Map scale
• North arrow
• Author of map
• Date of map creation

Hint: Add layout elements such as the title from the Insert menu. Add 
the table to the layout by opening it and then choosing Add Table to 
Layout from the Options button. If you experience difficulty creating 
the layout, refer to ArcGIS Desktop Help. Look at the topics under 
ArcMap, Laying out and printing maps.

d Print your map.

e Save your final map document.




